Plano Photography Club

Photoshop Training 2: Advanced
May 30, 2015

Topics covered:
» Advanced Selections
» Masking
» Smart Objects
» Composite Images
» Camera Raw Filter

Training Approach:

» | will follow step-by-step Script (in these notes) for much of class

* Watch me, then Do It yourself

* Script documents steps, so you can refer to it and repeat later by yourself

* Much of training session is demoing above Topics while building a Composite Image
» For Camera Raw topic, these training notes document how CR tools function

* | will demo most useful tools

* You can refer to notes to practice and try other tools later by yourself

Useful shortcut keys:
» Brush Size and Hardness:
e PC: Ctrl-Alt * } while dragging cursor right/left to increase/decrease brush size
* Mac: Ctrl-Option while dragging cursor down/up to increase/decrease brush hardness
» Photoshop Tool Selection:
* Letters select tools, e.g., L selects Lasso Tool (or whichever Lasso Tool last used)

* Shift toggles between tools in current group, e.g., Shift-L toggles between Lasso Tool,
Polygonal Lasso Tool and Magnetic Lasso Tool

Training session Script starts on the next page.

Notations used in document:
Keys are for Windows PC, but translate to Mac as follows:
Ctrl =Cmd on Mac Alt = Option on Mac

Photoshop version used:
Photoshop CC 2014

* PC: Alt-right click should also work.
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Selection using Refine Edge

A. Open Yana_trng.jpg in Photoshop

P wnNPRe

=

Click Ctrl-) to duplicate background layer

Click on background layer to select it, so that next step adds layer between the two layers
Click Layer/New Fill Layer/Solid Color, and pick a Red color to help in next step

Click on background layer copy to select it

Perform rough selection with Quick Selection Tool
Click W. If Magic Wand tool, click Shift-W to go to Quick Selection tool
Ensure +selection chosen, brush size to ~60 and hardness to ~75%

Ensure Auto-Enhance is checked, to produce smoother edges (unless it causes a
performance slow down)

Make a rough selection of Yana and couch using tool

Zoom in to 200%, lower brush size to ~20, and improve selection, making sure that blue
background does not show through loose hairs around head

Use Refine Edge to enhance selection

Click on Refine Edge... button at top of screen
a) Uncheck any boxes that are checked
b) Setall sliders to 0

Select On White (W) view from the View dropdown > 3
a) Note: multiple view options exist, which can be chosen by View: a 3 1
the single letters shown in the View dropdown —
b) The F key cycles through all views . Wait for spinning dots in
Start by sliding Radius slider to right, to about 35 pixels. ‘ bottom left corner of dialog
box to stop after each step

a) Note: some loose hairs have been added to selection

b) Click box for Show Radius (or click J) to see area with which Refine Edge is working
Slide Radius slider to about 100 pixels

a) The radius now visible for the image grows proportionally

b) Click J key to uncheck Show Radius box; note much more of hair is now selected

Click K key to select Black & White View; note that Yana’s left arm is part gray, as well as
some parts of her dress and hair

Click J key to Show Radius again
Click box for Smart Radius
a) Purpose of Smart Radius is to reduce the radius (down from 100 pixels we entered)
where possible, which in turn removes some fuzziness (gray) from the selection
b) Click J key to uncheck Show Radius box

Click V key to select Overlay View, which uses red to mask
image and shows both selected and unselected hair strands >

View:
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Edge Detection

9. Select the Refine Radius Tool from the icon left of Edge Detection > '
(V] Sm:

and then set Brush for ~50 pixels "4

10. Brush over the loose strands of hair all around her head

a) This adds to the radius that Photoshop looks at for making the selection

b) Toggle between R and K views to check for missed hair strands and brush over them
11. Eliminate edge on back of dress from Refine Edge process

a) Click Ctrl-J to Show Radius

b) Holding Alt-key, brush over area where back of dress meets background to remove
radius along that line

c) Click Ctrl-J to uncheck Show Radius box

12. Move Shift Edge slider to right (after trial and error, +5% seems to a good balance)
a) Shift Edge either reduces (-) or adds (+) to selection
b) Adding has effect of thickening hair, but can cause halos for non-hair areas

13. Effects of other sliders:
a) Smooth (set at 1): smooths edges of selection, but will lighten hair selections
b) Feather (set at 0.5): feathers edges, but this can also blur edge if not low
c) Contrast (set at 3): adds edge darkening, but easily overdone

14. Change View mode to On Layers (L)

15. Decontaminate Colors checkbox reduces background color fringing effect around hair
strands by replacing that color with color of hair

a) Check box to turn on, and double-click on Zoom tool to go to 100% magnified image
b) Move Amount slider to right to 75%, assessing effect
c) Tryclicking Decontaminate Colors box on/off to set impact

16. Check Remember Settings box to use above settings as starting point for future images

17. Output To: New Layer with Layer Mask is normally most useful choice

D. Address Selection Issues

=

To better see selection and potential issues, select layer just below layer just created

N

Click on Color Fill 1 layer’s properties icon, and pick White color to see selection issues:
a) Some lack of density on sofa edges and top edge of hand, and fuzziness next to left arm
b) Problem where hair and back of dress meet
c) Some hair areas appear flat
d) Note: no apparent issues with back of dress where we removed Refine Edge radius (C11)
3. To address 2a and 2b, select mask icon and use brush with White (reveal) or Black (hide)

‘Flat’ hair areas (2c) due to dark background peeking through hair strands or simply causing
some hair to take on darker colors, both of which reduced hair intensity during Refine Edge.

5. To try to avoid these issues, there’s a technique doing 2 selections, one for hair and one for
body, then combining them at: https://www.youtube.com/watch?v=Wzmms4SHTq8

E. Note: Selection demos on Internet typically use gray backgrounds, which greatly
improve effectiveness of Refine Edge tool.
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Il.  Start Composite with Main Subject To demons_trate multiple t_OOIS
and techniques, next sections

A.  Open Natalie.jpg will build a Composite Image

B. Note: selection of figure has already been made, as original image of her against
stone wall (not much different from her hair color) made selection time consuming

C. Want to add a bit of fantasy, so...

lll. Let’s Add Wings

A. Open Butterfly.jpg
1. Note: nice wing, fairly easy selection, but let’s try something different
2. Click Ctrl-) to duplicate background layer

B. Click: Select/Color Range, then use eyedropper to add/subtract colors, and fuzziness
slider to range of colors included... Ends up missing too much; Cancel out of it

C. Click: Select/Focus Area (need CC 2014), which works well for portraits and other
images where background is out of focus...

Auto chooses In-Focus Range, which works very well

Could use Refine Edge with very small radius and to smooth edge, and then our fill in
selection in interior area...

3. Butsince many won’t have CC 2014, cancel out of Refine Edge

D. Click: Quick Selection Tool; use it to highlight background, back wing and flowers
Click: Select/Inverse (Ctrl-Shift-1) to change selection to butterfly
Clean up selection by scanning/fixing edges, zoomed in
Click: Refine Edge; settings: Radius- 0, Smooth- 7, Feather- 0, Contrast- 5, Shift Edge- (-5),
Decontaminate Colors- unchecked. No radius or feathering to avoid light edge highlight.
4. Click: OK

E. Using resulting layer with just wing, rotate wing 25 degrees left (Edit/Rotate).

F. Duplicate layer (Ctrl-J) and flip duped layer so wings face each other
(Edit/Transform/Flip Horizontal).

IV. Move Wings to Natalie image
A. Click: on both wing layers in Butterfly image

B. Click: Move tool (V), then hold Alt-key and drag images (not layers) to Natalie.jpg
file; then Save Butterfly.psd and Close file

C. Click: Image/Reveal All to enlarge canvas to show all of both wings
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D. Duplicate Background layer using Ctrl-J, then drag dup to Top layer

E. Click: Magic Wand tool, set Tolerance to 10 and uncheck Contiguous
Click Wand anywhere on White backdrop
Click: Ctrl-Shift-I to invert selection

Click: Refine Edge, settings: Radius-9, Smooth-2, Feather-0, Contrast-6, Shift-Edge-(-16),
Decontaminate-58%. Click OK

4. White backdrop still showing is coming from bottom layer; click Eye at left of that layer to
remove visible white backdrop.

F. Stretch each wing to approx. 135% of its original size and position

Click on both Wing layers and then Click on Move tool (V)

Drag corner handle of move box out while holding Shift key (to maintain aspect ratio)

At top, click on ‘link’ icon and then type in 135 to W box (H box will automatically match)

. . , .
Click on ‘check mark’ icon to accept transform W: | 135% H:| 135.00%

Position each wing to one of Natalie’s shoulders; don’t worry about staying within canvas

A

G. Click: Image/Reveal All to enlarge canvas to show all of both wings

H. Note that Wings have faint square black outline (angled) around them, due to a
white border (not visible) along entire edge of each wing mask. To remove...

Click on ‘eye’ for background layer to make it visible, so that black outline visible
Click on either wing mask and select Brush tool set to black, size 100, hardness 100%
Paint over faint black lines on all 4 sides

P wnNPRe

Repeat for other wing
I. Let’s add some color to wings; Click on top wing layer

J.  Click: Layer/New Adjustment Layer/ Hue/Saturation; change wings to blue by
clicking on Colorize box, then moving top sliding to right till wings are blue (Hue=
+240) and 2" slider to right (Saturation=50)

K. Unclick ‘eye’ to hide background layer

L.  Click: File/Save to save this PSD file with all layers. Leave file open

Need to add Background for our “Butterfly Fairy”
A. Open Background flowers.jpg, then duplicate layer for safety (Ctrl-J)

B. Note: Before adding butterfly fairy into garden; we need to add some more flowers
1. Open SingleFlower.jpg

2. Note: the single flower file was created by selecting one flower, masking out background,
then saving just that flower image
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C.

©® N OV AW

10.

11.

12.

13.

14
15

Click: Move tool, with Alt-key, drag into Background flowers image (Alt-key centers it)
Close SingleFlower.jpg

Click: Magic Wand tool, check Contiguous, Click on white background of flower

Click on Layer Mask (which will hide flower, leaving only white background)
Double-click on Mask icon, and Click on Invert to show flower

Click: Edge Mask to now Refine Edge of flower.

a) Note: this technique of clicking on Mask makes Refine Edge available after initial
selection made

b) Select V for View mode
c) Use settings: Radius- 5, Smooth- 5, Shift Edge- (-10), rest- 0, Decon Colors- checked, 90%
d) Note that we’ll need to fix square border around flower
e) Toggle P-key to see effect of Refine Mask, then click OK
On flower mask, remove white border with black brush as with wings
Right click on Single Flower layer; choose Convert to Smart Object (SO) ,_ _|
a) Note: small icon in bottom right of that layer’s thumbnail >

b) Note: by saving as SO before resizing flower within image, \— —5,
full image quality (i.e., pixel count) is maintained

Move flower, and change size & orientation (X across flower means SO)

a) Vto pick Move tool

b) Hold Ctrl key and use cursor to drag corners of Move box to resize and reshape flower
Copy SO flower by dragging image with Move tool while holding Alt-key

a) Resize and reshape flower

b) Go back to reselect using Ctrl-click on flower image to access that layer
Double-click on one flower’s layer thumbnail

a) Opens .psb file, which is linked to original SO jpg file

b) Change color of flower and save

c) Note: all SO flowers linked to JPG show new color!

. Note: we easily added single flowers to image without increasing file size

. Note: we could have copied a SO layer, but that increases file size and is no longer linked to
original JPG (so changes to original file don’t propagate to SO files)

SAVE AS All flowers.psd

VI. Add Foreground flowers to Flower Garden

A.

B.

C.

D.

Open Foreground flowers.jpg
Select Move tool; Hold Alt-key; drag image to All flowers.psd
Move this layer to top of layer stack; rename as Foreground

Remove White backdrop (quick & dirty approach):
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E.

F.

o vk wN R

Click W for Wand tool; if not Magic Wand, click Shift-W to switch to it
Click on White backdrop

Click: Select/Modify/Expand and enter 5 pixels

Click: Select/Modify/Feather and enter 2 pixels

Click: Edit/Clear to erase selected area (white backdrop)

Click: Ctrl-D to Deselect

SAVE All flowers PSD

Close Foreground flowers JPG

VIl. Add our “Butterfly Fairy” to All flowers.psd

A.

r o

L.

1.

N

o u .k wnN e

Go to Natalie.psd (which is still open)
Click on background layer

Click Layer/New Fill Layer/Solid Color (pick any color since it will look blue due to
Hue/Saturation layer added earlier) — this layer helps show white outline on figure

Glyn Dewis’ technique to remove tiny white outline (halo) on boots & skirt
Click on model’s Mask
Click: Filter/Blur/Gaussian Blur and type in 2 pixels
Click L for Lasso tool; if not Lasso, click Shift-L to switch to it (repeat if needed)
Use Cursor to outline model’s head and hair; then Invert selection
Click: Image/Adjustments/Levels and move Input slider at far left to the middle, OK
Click: Ctrl-D to Deselect

Remove faint square white outline due to mask, using black brush like wings
Uncheck ‘eye’ on Color Fill layer added in A.2 to hide blue background

Click onto top layer, then Shift-Ctrl-Alt-E to make new top layer with full image
SAVE file

Click on top layer (containing full image with wings)

Click V (Move tool); Drag layer into All flowers.psd

Rename layer: Natalie

Drag this layer to just behind Foreground layer

Ensure position of Natalie layer within image looks good and is about 1/3rd from left
side of image

SAVE All flowers.psd
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VIIl. Create Depth in composite image

A.

B.

No uh wnNRE

w N e

4.

Note: we’ll create depth using 3 techniques: fading background, blurring
background, and forced perspective

First, group background layers to visually organize Layers panel

Select background layers (i.e., all but Foreground, Natalie, and original Background layer) by
either (a) clicking on each while holding Ctrl-key, or (b) clicking on top and bottom layers
while holding Shift key.

Click: Ctrl-G to group selected layers; Note Group 1 controls included layers

Add fading to background layers
Expand Group; then Click on top layer within Group
Click: Layer/New Fill Layer/Solid Color (pick medium gray, R/G/B all = 125)
Rename layer: Fade Background
Change layer Opacity to 50% (at top of Layers Panel)
Click on Mask in this Fade Background layer
Click: G for Gradient tool; if not Gradient, use Shift-G until Gradient

Using cursor on image, start below and outside of image, and drag cursor straight up to just
short of top of screen

a) Mask icon should show graduated white (top) to black coloring

b) Try different starting/ending points (both outside and inside of image), and diagonal
directions for gradient line. Remember White reveals, Black conceals.

c) Also, Click on Gradient icon in Layers Panel to open Color Picker again; then try picking
gray %-way down left side (R/G/B all = 190), and %-way down (R/G/B all = 60), to see
effects of darkening or lightening Fade Background layer.

Add Blur to background layer
Click on background layer (last layer in Group)
Right Click on layer in Layer Panel and choose Convert to Smart Object
Click: Filter/Blur/Gaussian Blur, and type in 5 pixels; click OK
a) Note: Filter on Smart Object creates nondestructive Smart Filter with layer
b) Able to use mask of Smart Filter in normal way to conceal (part of) effect
c) Able to edit Smart Filter by clicking on Gaussian Blur name below mask
NOTE: blur adds greatest depth where blur the greatest

Add Forced Perspective to background Group of layers
Click on Group 1 layer
a) Click: Edit/Transform/Perspective
b) Drag top left bounding box slightly to right (~ 3); click ‘check mark’ at top
Click C for Crop tool
a) Uncheck Delete Cropped Pixels at top (in case you want to later change perspective)
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3.

b) Adjust Crop handles to remove blank areas of image; click ‘check mark’ at top
SAVE image

IX. Add Shadow to Natalie & Wings (using Hal Wallar’s technique)

A.

B
C.
D

Add New Layer just above Group 1 layer; rename layer Shadow
Click L for Lasso tool; type in 25 px in Feather box at top
In Shadow layer, loosely outline Natalie and Wings

Fill in selection with neutral gray (R/B/G all = 130)
Click G for Paint Bucket; if Gradient, use Shift-G until Paint Bucket
Click cursor in selected area on Shadow layer to fill in gray
Click Ctrl-D to Deselect

Change blend mode from Normal to Multiply at top of Layers Panel

Click: Edit/Transform/Distort, then hold Ctrl-key and use handles to deform to
desired shadow shape.

Adjust layer Opacity to about 65%

X. Balance brightness of Natalie’s face and foreground flowers

A.

B.

C.

o wu .k wnN e

Brighten Natalie’s face
Click on Natalie layer in Layers Panel

Click: Layer/New Adjustment Layer/Brightness-Contrast, check Clipping Mask (Clipping
Mask causes adjustment to only affect layer immediately below.)

Set Brightness to ~25 and Contrast to -2
Click on Mask; paint Black on wings and legs, so adjustment only on face and torso

Tone down foreground flowers
Click on top Foreground layer in Layers Panel
Click: Layer/New Adjustment Layer/Curves, check Clipping Mask
Select Red channel from dropdown and drag top-right handle down
Select Green channel from dropdown and drag top-right handle down
Select Blue channel from dropdown and drag the top-right handle left
Note: cumulative affect is to mute strong flower colors.

SAVE All flowers.psd
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Xl. A Few Additional Photoshop Notes

A. Layer Tips

1. To change the size of thumbnails in Layers Panel, select top right icon on Layers Panel, then
Panel Options, and then thumbnail size

2. Layer Opacity controls intensity of layer; Layer Fill controls intensity of contents of layer, but
not Layer Style effects.

B. Selection Tips
Hold Spacebar while making selection to move entire selection around screen

2. To move an existing selection, hover cursor over selection, then hold Ctrl and drag to move
to new position

3. Can move selection in Mask by using Move tool (V)
Can edit selection in Mask by using Edit commands such as Transform

C. Mask Tips

1. Able to change Properties of Mask by double-clicking on Mask icon in Layers Panel
a) Can Refine Edge for selection in Mask by clicking Mask Edge
b) Can Invert selection in Mask by clicking Invert
c) Can change Density (blackness) or Feather amounts

2. To temporarily Turn Mask on or off...
a) Right click on Layer Mask, then Disable/Enable, or
b) Hold Shift key and click on Mask in Layer Panel
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Xil. Adobe Camera Raw (CR) Basics

A. Benefits of Raw Capture & Raw Processing
1. Raw capture image come straight from sensor
2. Raw processing allows non-destructive adjustments via Camera Raw (or Lightroom)
3. Raw processing allows more flexibility, speed (no render/save time), and creativity
4. Note: Camera Raw can be used stand-alone or as PS Filter (in CS6 and CC versions)

B. Camera Raw Interface

1. Tools/Preferences (at top left of screen)

White Targeted Straighten Red Graduated CR Rotate 90
Zoom (Z) Balance (I) Adjstmt (T) (A) Eye (E) Filter (G) Preferences CW (R)

O\~ [ "o, || 1, & || o/ @O |=| DG

Move (H) Color Crop (C) Spot Adjustment  Radial Rotate 90
Sampler (S) Removal (B)  Brush (K)  Filter (]) CCW (L)

2. Full Screen mode, Histogram and Camera settings

Full Screen
toggle (F)

Full screen is
preferred
editing mode

f/4 1/1000s Camera settings

ISO 2000 55-200@55 mm for current image

3. Panels (below Histogram); Panel icon choice affects which sliders shown below it

Sharpen Split (Your)
BASIC & NR Toning Effects Presets

& Z MBS AEED
Tone HSL / Lens Camera (Your)
Curve Grayscale Correction Calibration Snapshots

4. Workflow Options “link” (centered below image window)

Adobe RGB (1998); 8 bit; 3936 by 2624 (10.3MP); 300 ppi

a) Opens dialog to set CR output as shown in “link”

b) Allows setting color space outputted from CR
(recall that CR and LR don’t use any color space)

c) Other output setting (similar to LR outputs) for file size & pixel dimensions, sharpening,
print/paper (including soft proofing)

d) Able to save specific outputs above as Presets

e) Presets can be accessed by right-clicking on Workflow Options “link”
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5.

Various Before/After Views of changes to image (at bottom right of image window)

— Hover over each icon to see specific view options. Note: last icon shows
|_-, lilgl Iz’ Before/After for current slider panel only, i.e., not full set of image changes.

XIll. Camera Raw Editing Flow

A. Overview

1.

WK N LR WM

From Bridge, double-click to open raw file in CR.
a) Ifjpg file, open from Bridge by right clicking and selecting “open in CR”.

b) Ifusing CR as a filter in Photoshop (only in CS6 and CC), convert image to Smart Object to

allow re-opening CR filter to go back and tweak previous CR changes.
Lens Correction — makes image corrections based on camera lens used
Camera Profile Presets — allows broad adjustments by selecting different profiles
Basic Panel — most work (90%+) done here
a) White Balance
b) Exposure
c) Highlights
d) Shadows
e) White and Black Points
f)  Clarity, Vibrance and Saturation

All Other Adjustments — includes cropping, sharpening, noise reduction, adjustment brush,
graduated and radial filters, spot removal, vignetting and more

Camera Raw & Shortcut Keys
| key to select White Balance, which displays Basic Panel selections
F key to toggle to Fullscreen mode
P key to toggle to Previous (original) view
Q key to cycle between various Before/After views, including split screen views
Double-click on Zoom tool to change image to 100% magnification
Double-click on Hand tool to change image to fill the window (same as Ctrl-0)
Double-click slider to reset to zero
Double-click slider while holding Shift-key to Auto set that slider

When finished editing: Done saves settings made; Open Image opens in PS;
Save Image saves as (renamed) image

XIV. Detail of Camera Raw Editing Steps

A.

1.
2.

Lens Correction Panel
Check box “Enable Lens Profile Corrections”
If not automatically found, search for Lens Profile in dropdowns
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B. Camera Profile within Calibration Panel

1. Camera Profile —in Name dropdown
(1) Experiment with different Camera Profiles for desired result
(2) Camera Profiles are based on camera used
(3) Camera Profiles provide more punch than Adobe Standard

2. Process dropdown (at top of panel) — see info at end of this document

C. White Balance within Basic Panel

1. Select White Balance (eyedropper) in Tools menu, or press I-key
(either opens Basic Panel) White Balance: | Cloudy

2. Three Methods to set White Balance: Temperature 6500

a) Eyedropper (I shortcut key)
(1) Use with gray card, or click on neutral part of image.

Tint +10

(2) Neutral not required to be gray, just somewhere in middle tonal value.

b) White Balance dropdown Auto
(1) Usually produces decent result, and provides starting point for further tweaking.
(2) May need to further adjust Temperature/Tint to produce artistic effect desired.

c) White Balance dropdown Presets, e.g., Cloudy (only for raw files, not jpg)
(1) Can be a bit better than Auto.
(2) Still may want to further adjust Temperature/Tint for artistic effect desired.

D. Exposure within Basic Panel & =

1. Move slider to improve exposure, checking histogram to avoid l ‘
clipping (especially whites), as shown by up arrows on each end > il

Exposure slider makes more dramatic changes than other sliders
In CS6 and CC, Exposure slider controls full range of image, including midtones
In CS5, Exposure slider weighted toward controlling Highlights

E. Highlights within Basic Panel
Adjust Highlights slider, if needed, especially to remove clipping

If this isn’t enough to eliminate Clipping, select Tone Curve Panel (under Other Camera Raw
Adjustments, below)

3. In CS5, Highlights called Recovery

F. Shadows within Basic Panel

1. Slider works to lighten dark or silhouetted areas, but only need to fix problems that are
actually there

2. In CS5, Shadows called Fill Light

G. White and Black Points within Basic Panel
Setting White Point & Black Point like setting Levels in PS
Hold Alt-key while moving sliders to see view of where clipping is occurring

When white starts to show in black area, you have a white point, i.e., point at which
highlight clipping starts to occur
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4. When black starts to show in white area, you have a black point, i.e., point at which black
clipping starts to occur

Note: White clipping loses detail, but clipping of some color, including black, can be okay

Using Contrast slider at this point can punch up image, if needed, by lightening lights and
darkening darks

7. May need to revisit Exposure after above changes

H. Clarity, Vibrance and Saturation within Basic Panel

=

Clarity — enhances detail by increasing mid-tone contrast
a) Works better with images with a lot of detail
b) Don’t use on images that should be soft, e.qg., brides
2. Vibrance —increases saturation on areas that have less saturation (nonlinear)

a) So Vibrance works better than Saturation in pumping up weak colors, while not pumping
up (and overdoing) more vivid colors

b) Tend to use more for Landscape and Travel images
c) Algorithm avoids changing flesh colors

w

Saturation — puts more color into all colors

b

May need to revisit Temperature & Tint after above changes

I.  Adjusting Multiple Images at One Time

Select multiple similar images to start and open in CR

Select one image and make adjustments

In left panel where the multiple images are displayed, click Select All
Ensure that photo you adjusted is one with blue outline

iAW

Click Synchronize...
a) Check box for each item you want to sync

b) If you want just one, hold Option-key and click that one, which will uncheck the rest of
the boxes (in CC only)

XV. Other Camera Raw Adjustments

A. Tone Curve Panel

Use Point curve rather than Parametric

2. Goal: Add extra contrast, beyond what previous sliders could Tone Curve

do, and more selectively, i.e., highlights, midtones, shadows *Parametric. Point
3. Curve dropdown provides easy way to quickly add snap > Curve: | Medium Contrast
S-curve frequently used to add punch

5. To eliminate Clipping, drag extreme right topmost point down
very slightly till Clipping gone >

6. Can use specific color channels to address specific colors issues (but this is unusual)
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B. Detail Panel
(Use Alt-key with sliders to see changes in grayscale or other special modes)

1. Sharpening (Zoom to 100% by double-clicking on Zoom tool)
a) Amount: strength of sharpening applied; based on appearance & usually less than 100%
b) Radius: for most cameras, use 1.4 or 1.5; too much causes halo effect

c) Detail: how much gets sharpened; low just causes main edges to sharpen
(near O for portraits, higher for architecture)

d) Masking: removes sharpening from flat toned areas (e.q., faces, skies)
— Alt-key with slider shows these masked areas (in black)

2. Noise Reduction (Zoom to 100%)
a) Luminance - slide to get rid of white noise, by blurring image
b) Luminance Detail — brings back some lost detail, but too much brings back noise
c¢) Luminance Contrast — not hooked up in CS6 (or in CC?)
d) Color - reduces color noise
e) Color Detail — brings back some lost detail

f)  Color Smoothness — defaults to 50 when Color slider moved
(1) Moving right: tries to get color fidelity correct
(2) Moving left: focuses on blending colors smoothly

3. These adjustments apply to bigger and/or printed images, not web sized images, since noise
less noticeable on smaller, web images

C. HSL/Grayscale Panel

1. Convert to Grayscale checkbox
a) Sliders just affect darkness/lightness
b) Can also use Targeted Adjustment tool directly on image
c) Note: can go back to Basic Panel to impact image

2. HSL = Hue/Saturation/Luminance tabs
a) Allows working with specific color within image
b) Alternative: use Targeted Adjustment tool directly on image

D. Split Toning Panel

1. More often used to produce a special effect
2. Enables applying tones (Hue & Saturation) to Highlights and/or Shadows
3. Frequently used with B&W images to add touch of color

E. Effects Panel

Grain — adds grain back into image

N

Post Crop Vignetting — great way to quickly add vignetting

F. Presets Panel

1. After working on an image, able to save some/all of adjustments as a Preset
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2. From within Presets, click on folded paper icon > —_—
(just above Done button at bottom right) G o

Name Preset and select which adjustments get saved

W

Saved Presets show up in Presets Panel area

G. Snapshots Panel (similar to virtual copies in LR)

Able to save Snapshot of image at any point in editing process

Q]

From within Presets, click on folded paper icon >
(just above Done button at bottom right)

Name Snapshot
Saved snapshots show up in Panel area
Enables comparing snapshots to each other quickly

o vk w

Snapshots are saved with raw file

H. Crop Tool

Use Crop icon dropdown to select Aspect ratio (which is not image size)
After Crop area selected, press Return to crop

To re-crop, select Crop tool and repeat

P w N e

Can be used with straightening tool

I.  Spot Removal Tool

Select Type from dropdown: Heal or Clone

NoE

Heal blends into ‘target’ (area in red circle) based on ‘source’ (green circle),
while Clone makes an exact copy in ‘target’ using ‘source’

3. Inother words, area in Green circle used as input to area in Red circle

Note: By using a flat background for ‘source’, Heal will uses flat texture (not color of
background) to remove blemish on skin

To delete a healed spot, select it and hit Delete key

Click Visualize Spots box at bottom right to more > (| visualize Spots
easily see spots/blemishes

7. Click Show Overlay to see/hide brush circles on image > /] Show Overlay

Note: able to paint line/row, not just circle with tool (CC only?)

9. If Image Sensor dirty, causing same spots on multiple images, then those spots can be
removed from multiple image by synchronizing with image that has spots removed from it.

J.  Adjustment Brush Tool

Adjustment Brush allows painting over image to effect adjustments selected using sliders

NoE

Frequently used to dodge and burn by painting Exposure adjustments on image

New/Add/Erase radio buttons at top of panel allow creating New adjustments, or
Adding to and Erasing existing Adjustments

4. Each separate Adjustment is represented by its own Pin on the image
a) Pins are shown as circles; the active Pin has a dot in the circle >
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b) Overlay checkbox at bottom of panel will show/hide Pins

5. Adjustment Brush quick set up: Click on + sign at right, © ITemperature 0
or —sign at left, to set that slider and Reset all other slidersto0> © Tn +50
a) Repeated clicks on +/- signs will increment slider value - B —

b) Sliders can be moved before or after adjustment painted on image
6. Brush characteristics at bottom of panel

a) Flow slider controls how quickly effects flows out of brush

b) Density slider controls intensity of all of slider controls

c) Auto Mask limits area Brush paints, by detecting “adjacent” areas and excluding them,
so long as crosshairs of Brush stays within desired area. Note: Auto Mask slows down
painting process, due to the additional computations required.

7. Using Brush creates Mask, which can be displayed by checking box > (V] Mask [ ]
a) Y-key also toggles Adjustment Brush masks on/off
b) Hovering Brush over non-active Pins displays that Pin’s mask

8. Tip: to create off-center vignette:
a) Paint negative exposure over entire image to darken

b) Then Click Erase radio button at top and paint over portion of image to highlight... by
removing negative exposure

9. Tip: to clear up person’s skin:
a) Move Clarity slider to negative
b) Then paint over person’s skin, which will soften skin (i.e., remove detail)

K. Graduated Filter Tool
Select tool and drag cursor across image

Filter effect goes from Red to Green dots/lines with 100% of effect on other side of Green
dot, and 0% effect on other side of Red dot

3. Adjust position of filter box on image by dragging dashed lines of rotating
Use sliders to further adjust filter effect of active Graduated Filter
5. Tip: great for using like a ND filter for sky

L. Radial Filter Tool
Select tool and drag cursor across image to create ellipse

2. Filter effect goes from Red dot to Green elliptical dashed line with 100% of effect on other
side of Green line... if Effect radio button Outside is checked

3. IfInside button is checked, effect is reversed
Adjust position of filter ellipse on image by dragging handles or rotating
5. Use sliders to further adjust filter effect of active Radial Filter

XVI. Additional Camera Raw Settings

A. Process Version [2003, 2010, 2012(current)] S ey oy

Camera Calibration e P
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1. Dropdown under Camera Calibration icon
in Panels

a) Affects only middle-group of sliders (Exposure, Contrast, Highlights, ...) in Panels

b) Only matters if you edited image in earlier PS version (e.qg., C54 or CS5), in which case CR
will display “V” in bottom right
c) You can use older version sliders or...

Vibri
—

Satu

I/I ”
.

d) openin < click on “V” to get new sliders, using latest version

2. For any new images not previously edited, CR will use current version

B. To set all images, including JPGs, to Open in Camera Raw...

1. Goto Camera Raw preferences in Bridge
JPEG and TIFF Handling

JPEG: | Automatically open all supported JPEGs

TIFF: | Automatically open all supported TIFFs

2. < Select these dropdowns
XVII. Image Examples for CR Adjustments Camera Raw Editing Flow
(Live training class only) Lens Correction
Camera Profile Presets
A. Open Zoo_snapshots_0303.ARW Basic Panel
1. Click: F key to toggle to Fullscreen mode * White Balance
2. Select White Balance from Tools menu at top * Exposure

* Highlights
* Shadows
B. Open Zoo_multi_0175.ARW *  White and Black Points

1. Follow Editing Flow at right * Clarity, Vibrance and Saturation
All Other Adjustments

3. Follow Editing Flow at right

2. Demo Editing Flow, Adjustment Brush, Vignetting
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